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ค�ำน�ำ

ภ	าษา C เป็นหนึ่งในภาษาคอมพิวเตอร์ที่มีผู้ใช้งานเป็นจ�ำนวนมากในปัจจุบัน เนื่องจาก 

	ลกัษณะโครงสร้างทีไ่ม่ซบัซ้อนจนเกนิไป จงึเรยีนรูไ้ด้ไม่ยาก รวมทัง้ความเรว็ในการประมวล

ผลและความสามารถที่โดดเด่นในอีกหลาย ๆ  ด้าน ดังนั้น สถาบันการศึกษาส่วนใหญ่จึงมักเลือก

ภาษา C ในการเรียนการสอนส�ำหรับวิชาการเขียนโปรแกรมระดับเริ่มต้น และแม้ว่าภาษา C  

จะถูกสร้างมานานมากแล้วก็ตาม แต่ซอฟต์แวร์หลัก ๆ  ที่เราใช้งานกันอยู่ในทุกวันนี้ ล้วนถูกสร้าง

จากพ้ืนฐานของภาษา C แทบท้ังสิ้น เช่น ระบบปฏิบัติการต่าง ๆ  โปรแกรมด้านฐานข้อมูลและ

ธุรกิจอุตสาหกรรม การค�ำนวณทางวิทยาศาสตร์ Game Engine และอื่น ๆ  อีกมากมาย ดังนั้น 

การเขียนโปรแกรมด้วยภาษา C จึงเป็นสิ่งส�ำคัญอีกอย่างหนึ่งที่ผู้ต้องการก้าวสู่สายงานด้านการ

พัฒนาซอฟต์แวร์ระดับมืออาชีพควรต้องเรียนรู้เอาไว้

หนงัสอืเล่มนีไ้ด้รวบรวมเนือ้หาทีจ่�ำเป็นต้องรู้ในขัน้พืน้ฐานทัง้หมด พร้อมตวัอย่างประกอบ

เพื่อเสริมความเข้าใจอีกเป็นจ�ำนวนมาก โดยใช้เครื่องมือยอดนิยมอย่าง Visual Studio Code 

(VS Code) ร่วมกับตัวแปลภาษา MinGW ซึ่งผู้เริ่มต้นศึกษาการเขียนโปรแกรม สามารถเรียนรู้

ด้วยตนเอง รวมถึงเป็นแนวทางส�ำหรับศึกษาเพิ่มเติมจากแหล่งข้อมูลอื่น ๆ  ต่อไปได้
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ก่	อนที่เราจะเข้าสู่ขั้นตอนการเขียนโค้ดภาษา C ตามที่จะกล่าวถึงในบทต่อ ๆ  ไป สิ่งที่เรา 

	จ�ำเป็นต้องจัดเตรียมเอาไว้ล่วงหน้าก็คือ เครื่องมือในการเขียนโค้ดและทดสอบเพื่อ 

ดูผลลัพธ์ ซ่ึงแม้จะมตีวัเลอืกอยู่มากมาย แต่ในหนงัสอืเล่มนี ้จะเลอืกมาน�ำเสนอเฉพาะเครื่องมอืที่

ได้รับความนยิมสงูสดุในปัจจบุนั โดยเครื่องมอืทีเ่ลอืกนี ้ไม่ใช่เฉพาะกบัการเขยีนโค้ดภาษา C เท่านัน้  

แต่ยังสามารถน�ำไปใช้ส�ำหรับการเขียนโค้ดภาษาคอมพิวเตอร์อื่น ๆ  ได้เกือบทั้งหมด จึงถือเป็น 

ข้อได้เปรียบอย่างหนึ่งเมื่อเราศึกษาเรียนรู้การเขียนโปรแกรมภาษาอื่น ๆ  เพิ่มเติมในอนาคต

การติดตั้ง VS Code
การเขียนโค้ดภาษา C น้ัน แม้เราจะมี

เครื่องมือให้เลือกใช้มากมาย แต่ในที่น้ีผู้เขียน

จะแนะวิธีการที่ได้รับความนิยมสูงสุดในปัจจุบัน

เพียงวิธีเดียว นั่นก็คือ การใช้งานผ่าน Visual 

Studio Code (เรานยิมเรยีกสัน้ ๆ  ว่า VS Code) 

อย่างไรก็ตาม เน่ืองจาก VC Code ไม่ได้ถูก

สร้างมาส�ำหรับการเขียนโค้ดภาษา C โดยตรง 

แต่สามารถใช้กับภาษาคอมพิวเตอร์ทั่ว ๆ  ไป ได้

เกือบทั้งหมด ดังนั้น เรายังต้องติดตั้งเครื่องมือ

อื่น ๆ  เพ่ิมเติมอีก โดยขั้นตอนที่จ�ำเป็นต้องท�ำ

สามารถสรุปได้ดังนี้

การจัดเตรียมเครื่องมือ
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1.	 ติดตั้ง Visual Studio Code (VS Code) เพื่อใช้เป็นเครื่องมือหลักในการเขียนและ

แสดงผลลัพธ์รวมถึงจัดการไฟล์ของโค้ด

2.	 ติดตั้ง MinGW เพื่อเป็นตัวแปลภาษา (Compiler) ของภาษา C 

3.	 เซตต�ำแหน่งที่ติดตั้ง MinGW ลงใน Environment Variables ของระบบ เพื่อให้

โปรแกรมอื่น ๆ  รู้ต�ำแหน่งของตัวแปลภาษา

4.	 ติดตั้งส่วนเสริม C/C++ Package ลงใน VS Code เพื่อเป็นตัวช่วยในการเขียนโค้ด

ภาษา C

5.	 ติดตั้งส่วนเสริม Code Runner ลงใน VS Code เพื่อเชื่อมโยงระหว่าง VS Code 

กับ MinGW ซึ่งจะช่วยให้เราสามารถรันทดสอบโค้ดได้ง่ายขึ้น รวมทั้งตั้งค่าการแสดง

ผลลัพธ์อีกด้วย

ทั้งหมดที่กล่าวมา จะแยกกล่าวรายละเอียดเป็นหัวข้อต่าง ๆ  ในล�ำดับต่อไป แต่ในหัวข้อนี้

จะกล่าวถึงขั้นตอนแรกนั่นก็คือ การติดตั้ง VS Code ซึ่งเป็นโปรแกรมประเภท IDE (Integrated 

Development Environment) ที่ Microsoft สร้างขึ้นมาส�ำหรับใช้ในการเขียนโค้ดทั่ว ๆ  ไป และ

ได้รับความนิยมสูงสุดในปัจจุบัน เน่ืองจากมีลักษณะที่โดดเด่นหลายประการ เช่น ให้ใช้งานฟรี 

รองรับการเขียนโค้ดได้หลายภาษา และที่ส�ำคัญคือ มีส่วนเสริมการท�ำงานให้เลือกใช้มากมาย

ส�ำหรับการติดตั้ง VS Code ลงในเครื่องที่เราจะใช้งาน มีขั้นตอนโดยสังเขปคือ

1.	 สามารถดาวน์โหลดชุดติดตั้งได้ที่ https://code.visualstudio.com/download

2.	 เลือกดาวน์โหลดให้ตรงกับระบบปฏิบัติการที่เราก�ำลังใช้งาน (ในที่นี้จะกล่าวถึงเฉพาะ

ระบบ Windows เท่านั้น)

3.	 หลังจากดาวน์โหลดเสร็จ ให้ดับเบิลคลิกไฟล์ติดตั้งที่ได้มา และในหน้าจอถัดไป ก็

ยอมรับเงื่อนไขแล้วคลิกปุ่ม Next
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4.	 ขั้นตอนต่อไป จะมีออปชันให้เลือก ก็แนะน�ำให้เลือกทั้งหมด แล้วคลิกปุ่ม Next

1

2 2

1

5.	 ต่อจากนั้น คลิกปุ่ม Install เพื่อเริ่มการติดตั้งไฟล์ จากนั้นก็รอจนกว่าจะแล้วเสร็จ

การติดตั้ง MinGW
การที่ภาษาคอมพิวเตอร์จะท�ำงานได้นั้น ต้องอาศัยตัวแปลภาษา (Compiler) ซึ่งสิ่งนี้ ไม่

ได้ถกูตดิตัง้มาพร้อมกับ VS Code โดยเราต้องตดิตัง้เพิม่เตมิลงไปต่างหาก ซึง่ตวัแปลภาษา C มี 

ผูส้ร้างให้เลือกใช้มากมาย ส�ำหรบัในทีน้ี่จะใช้ตวัแปลภาษาของ GCC (GNU Compiler Collection)  

ที่ได้รับความนิยมสูงสุด แต่จะใช้ในเวอร์ชัน MinGW (Minimalist GCC for Windows) ซึ่งเป็น 

การลดขนาดของตัวแปลภาษาลงส�ำหรับใช้งานบนระบบ Windows โดยตรง ทั้งนี้ MinGW มีทั้ง



16  การเขียนโปรแกรมภาษา C ขั้นพื้นฐาน

แบบติดตั้งด้วยไฟล์ Installer และแบบคัดลอกไฟล์มาไว้ในเครื่องก็ใช้ได้เลย โดยแบบ Installer 

นั้นจะมีขั้นตอนการติดตั้งปลีกย่อยซึ่งค่อนข้างยุ่งยากเล็กน้อย ในที่นี้ผู้เขียนจึงจะกล่าวถึงเฉพาะ

แบบคัดลอกไฟล์ เพราะสะดวก รวดเร็วกว่า โดยมีแนวทางการน�ำมาใช้งานดังนี้

1.	 สามารถดาวน์โหลด MinGW ได้ที่  

https://sourceforge.net/projects/mingw-w64/files/

แล้วเลื่อนลงมาคลิกที่ลิงก์ x86_64-win32-sjlj ดังภาพ (ชื่อไฟล์อาจถูกเปลี่ยนแปลง

ไปเร่ือย ๆ  แต่ควรเลือกไฟล์ชื่อขึน้ต้นด้วย x86_64-win32 อนัแรกสดุ ซึง่ตามปกต ิจะ

เป็นเวอร์ชันล่าสุด)

2.	 หลังจากดาวน์โหลดเสร็จ ปกติจะได้ไฟล์ที่ถูกบีบอัดเอาไว้ ก็ให้ขยายไฟล์ดังกล่าว ซึ่ง

หลังการขยายจะได้โฟลเดอร์ชื่อ mingw64 พร้อมกับไฟล์จ�ำนวนมากในโฟลเดอร์นั้น  

ก็ให้เราคัดลอกโฟลเดอร์ mingw64 ไปเก็บไว้ยังต�ำแหน่งที่เราอ้างอิงได้สะดวก ซึ่ง 

โดยท่ัวไป เรานิยมเก็บไว้ทีไ่ดรฟ์ C ดงัน้ัน ต�ำแหน่งของมันจะเป็น C:\mingw64 (หรอื

จะขยายไฟล์มาไว้ที่นี้โดยตรงเลยก็ได้) 

วธิีการตามทีผู่เ้ขยีนเลือกใช้ดังทีก่ล่าวมานี้ เราเพียงแค่คดัลอกไฟล์มาก็ใชง้านได้แล้ว แต่

อย่าลืมต�ำแหน่งที่เราเก็บไฟล์เอาไว้คือ C:\mingw64 ซึ่งต้องใช้อ้างอิงในหัวข้อต่อไป
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การเซตต�ำแหน่งของตัวแปลภาษา
แม้เราจะน�ำชุดไฟล์ของ MinGW มาจัดเก็บในเครื่องแล้ว แต่ระบบหรือโปรแกรมอื่น ๆ  ก็

ยังไม่รู้จักต�ำแหน่งของมัน ดังนั้น เราต้องเซตต�ำแหน่งของ MinGW ลงใน Environment ของ

ระบบ เพื่อให้โปรแกรมอื่น ๆ  รู้จักต�ำแหน่งของมัน และเข้าถึงได้ โดยมีขั้นตอนดังนี้

1.	 จากข้ันตอนการติดตั้งในหัวข้อที่แล้ว ผู้เขียนได้บอกไว้ว่า เราต้องจ�ำไว้ด้วยว่าติดตั้ง 

MinGW เอาไว้ที่ใด ซึ่งตามปกติหากใช้ตามค่าที่ผู้เขียนแนะน�ำ ต�ำแหน่งของตัวแปล

ภาษาก็จะอยู่ที่ C:\mingw64\bin ถ้าไม่แน่ใจ ให้เปิดไปตรวจสอบอีกครั้งก็ได้

2.	 ที่ระบบ Windows ให้คลิกขวาที่ปุ่ม Start แล้วเลือก System (หรือคลิกขวาที่ไอคอน 

My Computer หรือ This PC จากนั้นเลือกเมนู  Properties หรือใช้วิธีอื่น ๆ  นอก

เหนือจากน้ีก็ได้) แล้วในขั้นตอนถัดไปให้คลิกที่ลิงก์หรือเมนู Advanced system 

settings (ระบบปฏิบัติการแต่ละเวอร์ชันอาจจัดวางต�ำแหน่งที่แตกต่างกัน)

3.	 ในขั้นตอนถัดไป เมื่อปรากฏหน้าจอ System Properties ให้เลือกแท็บ Advanced 

จากนั้นคลิกที่ปุ่ม Environment Variables... 

4.	 เมื่อปรากฏหน้าจอ Environment Variables ให้คลิกที่ตัวแปร (Variable) Path จาก

นั้นคลิกปุ่ม Edit...
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1

2

3

4

5.	 เม่ือปรากฏหน้าจอ Edit environment 

variable ให้คลกิปุม่ New แล้วใส่ต�ำแหน่ง

ของ MinGW ลงไปตามที่ได ้จัดเก็บ 

ไฟล์เอาไว้ ซึ่งในกรณีของผู ้เขียนคือ  

C:\mingw64\bin ทัง้นีห้ากผูอ่้านจดัเกบ็ที่

ต�ำแหน่งอื่น กใ็ห้ระบไุปตามนัน้ เสรจ็แล้ว

คลิกปุ่ม OK

6.	 เม่ือย้อนกลับมายังหน้าจอในขั้นตอนก่อน

นี้ ก็ให้คลิกปุ่ม OK ทั้งหมด ก็ถือเป็น 

อันเสร็จสิ้นขั้นตอนการเซตค่า

การติดตั้ง C/C++ Package ส�ำหรับ VS Code
จากทีไ่ด้กล่าวไปบ้างแล้วว่า VS Code เป็นเครื่องมือส�ำหรับเขยีนโค้ดทัว่ ๆ  ไป ทีไ่ม่เจาะจง

ว่าจะใช้กับภาษาคอมพิวเตอร์อันใดอันหนึ่ง ดังนั้น หากเราจะใช้ในการเขียนโค้ดภาษาใด ก็อาจ

ต้องตดิตัง้ส่วนเสริม (Extension) เพื่อเป็นตวัช่วยส�ำหรบัใช้งานร่วมกบัภาษานัน้ ๆ  ส�ำหรับในกรณี

ของภาษา C ก็ให้เราติดตั้งส่วนเสริมที่ชื่อ C/C++ Package ที่พัฒนาโดยทีมงานของ Microsoft 

โดยตรง ดังขั้นตอนต่อไปนี้

1

2

3
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1.	 เปิดเข้าสู่ VS Code แล้วคลิกที่ไอคอน Extensions ที่แถบด้านซ้ายมือ (การติดตั้ง

ส่วนเสริมต้องเชื่อมต่ออินเทอร์เน็ต)

2.	 ในช่องค้นหา ให้พิมพ์ค�ำว่า C/C++  

ลงไป

3.	 หลังจากปรากฏรายชื่อส่วนเสริม ซึ่งมี

อยู่ค่อนข้างมาก แต่อันที่แนะน�ำให้ติด

ตั้งโดยคลิกปุ่ม Install ตรงส่วนเสริม

อันนั้น (หมายเลข 3 ในภาพ) คือ

1)	 C/C++

2)	 C/C++ Extension Pack 

ส่วนเสริม C/C++ เราติดตั้งดังขั้นตอนที่ผ่านมา เป็นเพียงตัวช่วยในการเขียนโค้ดเท่านั้น 

แต่หากเราต้องการความสะดวกสบายในการทดสอบโค้ดที่เขียน ก็อาจต้องติดตั้งส่วนเสริมอื่น ๆ  

เพิ่มลงไปอีก ตามที่จะกล่าวถึงในหัวข้อต่อไป

การติดตั้ง Code Runner ส�ำหรับ VS Code
การติดตั้ง VS Code และ MinGW รวมทั้งส่วนเสริมของ C/C++ ดังขั้นตอนที่ได้กล่าวมา  

แม้จะเพียงพอที่จะเขียนโค้ดภาษา C บน VS Code ได้แล้ว แต่ก็ยังมีความยุ่งยากในการรัน 

ทดสอบ เพราะหากต้องการดูผลลัพธ์ของโค้ดที่เขียน เราต้องพิมพ์ค�ำสั่งลงไปเอง ดังนั้น เพื่อลด

ความยุ่งยากดังกล่าว เราอาจติดตั้งส่วนเสริมของ VS Code ที่ชื่อ Code Runner เป็นตัวช่วย

ในขั้นตอนการรันทดสอบเพื่อดูผลลัพธ์ ดังขั้นตอนต่อไปนี้

1.	 เปิดเข้าสู่ VS Code แล้วคลกิทีไ่อคอน 

Extensions ที่แถบด้านซ้ายมือ (ต้อง

เชื่อมต่ออินเทอร์เน็ต)

2.	 ในช่องค้นหา ให้พิมพ์ค�ำว่า Code 

Runner ลงไป

3.	 หลงัจากปรากฏรายชื่อส่วนเสรมิ Code 

Runner ก็ให้คลิกปุ่ม Install

4.	 หลังติดตั้งเสร็จ ให้ปิดโปรแกรม VS Code แล้วค่อยเปิดขึ้นมาใหม่

1

2

3

3

1

2

3
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5.	 ต่อไปเราจะตั้งค่า เพื่อให้ Code Runner น�ำผลลัพธ์ไปแสดงที่ Terminal ของ VS 

Code โดยเลือกเมนู File > Preferences > Settings

6.	 การค้นหาตัวเลอืกเป้าหมาย วธิทีีส่ะดวกรวดเร็วทีสุ่ดคอื เม่ือเปิดเข้าสู่แทบ็หรือหน้าจอ 

Settings ให้พิมพ์ค้นหาด้วยค�ำว่า "code runner run in terminal" ก็จะปรากฏ 

ตัวเลือกเป้าหมายคือ Code-runner: Run In Terminal (รายการนี้จะปรากฏเมื่อ 

ตดิตัง้ Code Runner เอาไว้แล้วเท่าน้ัน) ต่อไปเรากเ็ลอืก (เชก็) ทีร่ายการนัน้ ดงัภาพ

1

2

7.	 หลังจากท�ำตามขั้นตอนดังที่กล่าวมาจนครบแล้ว ต้องบันทึกการเปลี่ยนแปลงเสมอ 

เช่น เลือกเมนู File > Save หรือกด <Ctrl + S> จากนั้นก็สามารถปิดแท็บ Settings 

ได้เลย และถือเป็นอันเสร็จสิ้นขั้นตอนการตั้งค่า

การเลือกที่ Run In Terminal ตามที่เราเซตค่าในขั้นตอนดังกล่าวมานี้ ก็เพื่อให้ Code 

Runner แสดงผลลัพธ์และรับข้อมูลจากคีย์บอร์ดผ่านทาง Terminal ของ VS Code โดยตรง

นั่นเอง

การทดสอบโค้ดภาษา C
หลังจากท่ีเราได้จัดเตรียมเครื่องมือที่ต้องใช้ส�ำหรับการทดสอบภาษา C จนครบทั้งหมด

แล้ว ดังหัวข้อที่ผ่าน ๆ  มา ขั้นตอนต่อไปเราก็จะทดสอบเครื่องมือเหล่านั้นว่าใช้งานร่วมกันได้จริง

หรือไม่ โดยมีแนวทางดังต่อไปนี้

สร้างโฟลเดอร์ส�ำหรับเก็บโค้ด

ตามหลักการที่ถูกต้องของ VS Code นั้น เราควรสร้างโฟลเดอร์ส�ำหรับจัดเก็บไฟล์ของ

โค้ดให้เป็นสัดส่วน เพราะการด�ำเนินการบางอย่างเราต้องท�ำกับโฟลเดอร์ที่บรรจุไฟล์เท่านั้น ซึ่ง

แนวทางที่ผู้เขียนจะเลือกใช้ประกอบในหนังสือเล่มนี้คือ
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•• ก�ำหนดโฟลเดอร์ชื่อ c-lang ส�ำหรบัเก็บโค้ดรวมของทกุบท โดยโฟลเดอร์นีจ้ะสร้างไว้ที่ 

C:\c-lang

•• เนื่องจากในแต่ละบท จะมีไฟล์ย่อย ๆ  ของแต่ละตัวอย่างเป็นจ�ำนวนมาก ดังนั้น เพื่อ

ให้ง่ายต่อการเข้าถึงไฟล์เป้าหมาย เราจะสร้างโฟลเดอร์ย่อย ๆ  ซ้อนไว้ใน C:\c-lang 

เพื่อจัดเก็บโค้ดของแต่ละบท เช่น

๏๏ โฟลเดอร์ chapter1 ส�ำหรับเก็บโค้ดของบทที่ 1 จะอยู่ที่ C:\c-lang\chapter1\

๏๏ โฟลเดอร์ chapter2 ส�ำหรับเก็บโค้ดของบทที่ 2 จะอยู่ที่ C:\c-lang\chapter2\

๏๏ โฟลเดอร์ chapter3 ส�ำหรับเก็บโค้ดของบทที่ 3 จะอยู่ที่ C:\c-lang\chapter3\

๏๏ โฟลเดอร์อื่น ๆ  ก็ใช้หลักการเดียวกัน ...

•• ในแต่ละบท จะสร้างไฟล์ตามชื่อบท-ล�ำดับตัวอย่าง เช่น

๏๏ โค้ดของตัวอย่าง 1-1 จะอยู่ที่ไฟล์ C:\c-lang\chapter1\example1-1.c

๏๏ โค้ดของตัวอย่าง 1-2 จะอยู่ที่ไฟล์ C:\c-lang\chapter1\example1-2.c

๏๏ โค้ดของตัวอย่าง 2-1 จะอยู่ที่ไฟล์ C:\c-lang\chapter2\example2-1.c

๏๏ โค้ดของตัวอย่าง 3-5 จะอยู่ที่ไฟล์ C:\c-lang\chapter3\example3-5.c

๏๏ โค้ดของตัวอย่างอื่น ๆ  ก็ใช้หลักการเดียวกัน ...
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หลังจากที่เราทราบหลักการโดยสังเขปแล้ว ต่อไปเราจะลองทดสอบการใช้งาน โดยในขั้น

ตอนแรก ถ้าเรายังไม่มีโฟลเดอร์รวม ให้สร้างขึ้นมาก่อน ดังนี้

1.	 เปิด File Explorer ของระบบ Windows แล้วไปที่ C:\

2.	 สร้างโฟลเดอร์ใหม่ชื่อ c-lang (เช่น คลิกขวาแล้วเลือก New > Folder)

3.	 เปิดเข้าไปในโฟลเดอร์ c-lang แล้วสร้างโฟลเดอร์ชื่อ chapter1 ส�ำหรับเก็บไฟล์ของ

บทที่ 1 (ขั้นตอนนี้ อาจไปสร้างใน VS Code ก็ได้)

การสร้างไฟล์และทดสอบโค้ดภาษา C

หลังจากที่เราสร้างโฟลเดอร์ส�ำหรับจัดเก็บโค้ดเอาไว้แล้ว ดังหัวข้อที่ผ่านมา ต่อไปเราจะ

สร้างไฟล์ภาษา C เพื่อทดสอบการท�ำงาน ดังนี้

1.	 เปิดเข้าสู่ VS Code

2.	 คลิกเมนู File > Open Folder หรือเลือกจากลิงก์ Open Folder บนหน้าจอ Get 

Started ก็ได้ จากน้ันเลือกโฟลเดอร์ของบทที่ 1 ตามที่เราได้สร้างเอาไว้ นั่นคือ  

C:\c-lang\chapter1 
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3.	 คลิกที่ไอคอน New File ดังภาพ แล้วก�ำหนด

ช่ือไฟล์ โดยให้มีส่วนขยายหรือนามสกุลของ

ไฟล์เป็น .c เท่าน้ัน (หมายถึงไฟล์ภาษา C)  เช่น

ในทีน้ี่ก�ำหนดชื่อเป็น example1-1.c

4.	 ให้ลองพิมพ์โค้ดง่าย ๆ  ลงไป ดังน้ี (รายละเอยีด 

ของโค้ดจะกล่าวถึงในบทต่อ ๆ  ไป)

5.	 หลังการเขียนหรือแก้ไขโค้ด ต้องบันทึกการเปลี่ยนแปลงทุกครั้ง เช่น เลือกเมนู File 

> Save หรือกด <Ctrl + S> 

6.	 รันทดสอบโค้ดที่เขียนด้วยวิธีใดวิธีหนึ่งคือ

๏๏ 	วิธีที่ 1	 คลิกที่ปุ่มไอคอนหัวลูกศรที่อยู่บริเวณมุมขวาบนของพื้นที่เขียนโค้ด

๏๏ 	วิธีที่ 2	 คลิกขวาบรเิวณพืน้ทีเ่ขยีนโค้ด แล้วเลอืกเมน ูRun Code (เมนรูายการนี ้

จะปรากฏเฉพาะกรณทีีเ่ราตดิตัง้ส่วนเสรมิ Code Runner เอาไว้แล้วเท่านัน้) หรอื

กด <Alt +Ctrl + N>

1

2
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7.	 เมื่อสั่งรันตามที่กล่าวมา ผลลัพธ์ที่ได้จะถูกน�ำมาแสดงบน Terminal (จะปรากฏโดย

อัตโนมัติ) ดังภาพ

อย่างไรกต็าม เนื่องจากการรนัโค้ดภาษา C จะได้ไฟล์ .exe เพิม่ขึน้มาอีกไฟล์ ซึง่โปรแกรม

ประเภท Anti-Virus อาจมองว่าไม่ปลอดภัย และอาจบล็อกการรันก็เป็นได้ ซึ่งเราอาจแก้ปัญหา

ด้วยวิธีใดวิธีหนึ่งคือ

•• 	 วิธีที่ 1	 อาจหยุดการท�ำงานของโปรแกรม Anti-Virus ชั่วคราวในระหว่างที่ก�ำลัง

ทดสอบการรันภาษา C แต่วิธีนี้อาจไม่ปลอดภัย หากในขณะนั้นเราใช้อินเทอร์เน็ต

ควบคู่กันไปด้วย

•• 	 วิธีที่ 2	 อาจสร้าง Exception ภายในโปรแกรม Anti-Virus เพื่อให้มันยกเว้นการ

ตรวจสอบต�ำแหน่งโฟลเดอร์ทีเ่ราจัดเก็บโค้ด เช่น ในทีน่ีค้อื C:\c-lang ดงัในภาพถดัไป  

เป็นการสร้าง Exception บนโปรแกรม Avast (เลือกไอคอน Menu > Settings > 

Exceptions > Add Exception)
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หากเราต้องการสร้างไฟล์ส�ำหรับตัวอย่างต่อ ๆ  ไป ก็ท�ำเหมือนเดิม นั่นคือ เปิดเข้าสู่ VS 

Code แล้วเข้าสูโ่ฟลเดอร์ C:\c-lang\chapterX ท่ีต้องการจดัเกบ็ไฟล์นัน้ แล้วกค็ลกิไอคอน New 

File จากนั้นก็ก�ำหนดชื่อที่มีส่วนขยายเป็น .c ตามเดิม ซึ่งเราจะสร้างเพิ่มกี่ไฟล์ก็ได้

หลังจากที่เราเสร็จสิ้นการใช้งาน อาจปิดโฟลเดอร์นั้น เช่น เลือกที่เมนู File > Close 

Folder แต่กรณีนี้ หากจะใช้งานเมื่อเข้าสู่ VS Code ครั้งต่อไป ต้องเปิดโฟลเดอร์ก่อน ตามหลัก

การเดิมทั้งหมด

การใช้เครื่องมือพื้นฐานของ VS Code
ก่อนที่เราจะเข้าสู่ขั้นตอนการเขียนโค้ดภาษา C อย่างเต็มรูปแบบในบทต่อไป ก็ควรรู้จัก

กับการใช้เครื่องมือพื้นฐานบางส่วนของ VS Code เพิ่มเติม เผื่อจ�ำเป็นต้องใช้งานในบางโอกาส 

โดยสิ่งที่เราควรรู้จักในเบื้องต้นมีดังนี้

หน้าจอเริ่มต้น (Get Started)

ตามปกติ เมื่อเราเปิดเข้าสู่ VS Code จะปรากฏหน้าจอ Get Started เป็นอันดับแรก ซึ่ง

ลักษณะที่ส�ำคัญเกี่ยวกับหน้าจอนี้คือ 

•• อาจมีการแจ้งข้อมูลข่าวสารที่น่าสนใจเกี่ยวกับ VS Code

•• มีลิงก์ส�ำหรับให้เราคลิกเพื่อเปิดไฟล์หรือโฟลเดอร์เป้าหมายที่ต้องการได้อีกหนึ่งวิธี 

นอกเหนือจากการเลือกที่เมนู

•• มีลิงก์ที่แสดงประวัติการเปิดโฟลเดอร์ที่เราเข้าสู่ VS Code ในครั้งก่อน ๆ  ซึ่งหากมี

โฟลเดอร์เป้าหมายที่เราต้องการรวมอยู่ด้วย ก็สามารถคลิกเปิดจากตรงนี้ได้ทันที
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	 หากเราต้องการปิดหน้าจอนี้ ก็คลิกปุ่ม X ที่แท็บด้านบน หรือหากไม่ต้องการให้ปรากฏ

หน้าจอ Get Started ต่อไปอีก ก็ให้เราเอาเครื่องหมายถูกตรงตัวเลือก Show welcome page 

on startup ที่บริเวณขอบด้านล่างออก หรือหลังจากปิดไปแล้ว หากเราต้องการให้หน้าจอ Get 

Stated กลับมาแสดงอีกครั้ง ก็ให้เลือกที่เมนู Help > Get Started 

การเลือกรูปแบบสี (Theme)

ตามปกติ VS Code จะเลือกธีม (Theme) เป็นสีด�ำ (Dark) เอาไว้ล่วงหน้า ซึ่งหากเรา

ชอบแบบนีก้ไ็ม่จ�ำเป็นต้องปรบัเปลีย่น แต่ถ้าเราต้องการสสีนัในรปูแบบอื่น กม็ตีวัเลอืกอยูจ่�ำนวน

หนึ่ง โดยใช้ขั้นตอนดังต่อไปนี้

1.	 ที่มุมล่างขวาของโปรแกรม VS Code ให้คลิกที่ไอคอน Manage (รูปเฟือง)

2.	 เลือกที่เมนู Color Theme

3.	 จากนั้นจะปรากฏรายชื่อสีให้เลือก ถ้าเรายังไม่ทราบว่าแต่ละสีมีลักษณะเป็นยังไง ก็

อาจลองเลือกดูก่อนก็ได้ ถ้าไม่ถูกใจก็ค่อยเลือกสีใหม่ ส�ำหรับรูปแบบที่จะใช้ประกอบ

ในหนังสือเล่มนี้ ผู้เขียนเลือกธีมสีแบบ Light (Visual Studio)
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2

3

1

การปรับเปลี่ยนฟอนต์

ฟอนต์ (Font: ในที่นี้คือตัวอักษรที่ใช้เขียนโค้ดและแสดงผลลัพธ์) ที่ VS Code ก�ำหนด

เอาไว้ล่วงหน้า แม้จะเป็นรูปแบบมาตรฐานที่นิยมใช้งานกันทั่วไป แต่หากต้องการใช้ฟอนต์ที่เรา

ถูกใจ ก็สามารถเปลี่ยนแปลงได้ด้วยขั้นตอนดังต่อไปนี้

1.	 ที่มุมล่างขวาของโปรแกรม VS Code ให้คลิกที่ไอคอน Manage (รูปเฟือง)

2.	 เลือกที่เมนู Settings

3.	 คลิกแท็บ Text Editor

4.	 คลิกแท็ก Font

5.	 ก�ำหนดชื่อฟอนต์ลงในช่อง Font Family ซึ่งตามปกติ จะมีฟอนต์เดิมที่ VS Code 

ก�ำหนดไว้ให้ล่วงหน้า หากเราต้องการเปลีย่นไปใช้ชนดิอื่น ควรเพิม่ชื่อฟอนต์ไว้ข้างหน้า 

ฟอนต์เดมิ (ชื่อทีอ่ยูก่่อนจะถกูพจิารณาก่อน และไม่แนะน�ำให้ลบชื่อฟอนต์เดมิออก) โดย 

คัน่ด้วยเครื่องหมาย , และถ้าชื่อฟอนต์ชนดินัน้มีช่องว่าง ให้เขยีนไว้ในเคร่ืองหมาย ' '  

ซึ่งชื่อฟอนต์ที่ระบุต้องถูกติดตั้งเอาไว้ในเครื่องนั้นอยู่ก่อนแล้ว (การติดตั้งฟอนต์ ให ้

คดัลอกไฟล์ของฟอนต์ไปไว้ที ่C:\Windows\Fonts แล้วเริม่โปรแกรมทีจ่ะใช้ฟอนต์ใหม่)

6.	 ถ้าต้องการก�ำหนดขนาด ก็ระบุตัวเลขลงในช่อง Font Size และเมื่อปิดหน้าจอ Setting 

ฟอนต์ที่ตั้งค่าเอาไว้ก็จะมีผลทันที
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นอกจากนี้ ยังมีเทคนิคเพิ่มเติมอีกอย่างคือ การย่อหรือขยาย (Zoom) ขนาดของฟอนต์ 

ในโปรแกรม VS Code ให้ใหญ่ขึน้หรอืเลก็ลง ซึง่กรณนีี ้จะมีผลกบัทัง้โค้ด เมน ูและข้อความอ่ืน ๆ   

ทั้งหมดบน VS Code โดยใช้วิธีการง่าย ๆ  คือ

•• หากต้องการขยายขนาดเพิ่มขึ้น (Zoom In: คล้ายกับการเข้าไปมองใกล้ ๆ  ซึ่งจะเห็น

ขนาดที่ใหญ่ขึ้น) ให้กดคีย์บอร์ดปุ่ม <Ctrl => หรือเลือกเมนู View > Appearance 

> Zoom In ซึ่งหากท�ำซ�ำ้เช่นนี้อีก ขนาดของฟอนต์จะเพิ่มขึ้น 1 ระดับ ไปเรื่อย ๆ

•• หากต้องการลดขนาดให้เล็กลง (Zoom Out: คล้ายกับการออกมามองไกล ๆ  ซึ่งเราจะ

เหน็ขนาดทีเ่ลก็ลง) ให้กดคีย์บอร์ดปุ่ม <Ctrl -> หรือเลอืกเมน ูView > Appearance 

> Zoom Out ซึ่งหากท�ำซ�้ำเช่นนี้อีก ขนาดของฟอนต์จะลดลง 1 ระดับ ไปเรื่อย ๆ

แนวทางการติดตั้งส่วนเสริมเพิ่มเติม

การเขียนโค้ดในบางกรณี เราอาจต้องใช้ส่วนเสริม (Extension) ส�ำหรับการท�ำงานร่วม

กับภาษานั้น ๆ  ซึ่งในหัวข้อที่ผ่านมา เราก็ได้ติดตั้งส่วนของภาษา C/C++ ไปแล้ว จึงขอกล่าวถึง

อีกครั้งหนึ่ง เนื่องจากส่วนเสริมของ VS Code ยังมีอีกเป็นจ�ำนวนมาก ซึ่งเราสามารถตรวจสอบ

และน�ำส่วนเสริมอื่น ๆ  มาใช้งานเพิ่มเติมได้ดังแนวทางต่อไปนี้
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1.	 ในขณะนั้น ต้องเชื่อมต่อกับอินเทอร์เน็ต แล้วคลิกที่ไอคอน Extensions ที่ขอบด้าน

ซ้าย (ดูภาพถัดไป) หรือเลือกที่เมนู View > Extensions

2.	 ใส่คีย์เวิร์ดลงไป หลังจากน้ันจะปรากฏรายชื่อส่วนขยายที่อาจเกี่ยวข้องกับคีย์เวิร์ด 

ดังกล่าว 

3.	 ถ้าเราต้องการติดตั้งส่วนเสริมใด ก็คลิกปุ่ม Install บนรายการนั้น หรือหากต้องการดู

รายละเอียดเพิ่มเติมเกี่ยวกับส่วนเสริมใด ก็คลิกที่รายการดังกล่าว ดังภาพ

3

1

2

4.	 ถ้าค้นหาส่วนเสริมใดที่ถูกติดตั้งเอาไว้แล้ว จะมีรูปไอคอน Manage ที่มุมล่างขวาของ

รายการนั้น ทั้งนี้หากเราต้องการลบส่วนขยายนั้นทิ้งไป จากนั้นท�ำดังนี้

(1)	คลิกที่ไอคอน Manage ที่ส่วนเสริมนั้น (รูปเฟือง)

(2)	เมื่อปรากฏเมนู ให้คลิกที่ Uninstall 

2

1
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การน�ำโค้ดของหนังสือมาใช้งาน
ส�ำหรบัโค้ดของหนงัสอืเล่มนี ้ผู้อ่านสามารถดาวน์โหลดได้ที ่https://www.developerthai 

.com หลงัจากนัน้กใ็ห้ขยายไฟล์ดงักล่าว ซึง่จะได้โฟลเดอร์ทีช่ื่อ c-lang กใ็ห้น�ำโฟลเดอร์ดงักล่าว

ไปเกบ็ไว้ที ่C:\ ดงันัน้ ต�ำแหน่งของมนักจ็ะเป็น C:\c-lang โดยภายในโฟลเดอร์ c-lang จะประกอบ

ด้วยโฟลเดอร์ย่อย ๆ  ของบทต่าง ๆ  เช่น chapter1, chapter2, ... ดังหลักการที่ได้กล่าวมาแล้ว 

เม่ือต้องการเปิดดูโค้ด และ/หรือ รันทดสอบ ก็ให้เข้าสู่ VS Code แล้วเปิดโฟลเดอร์ 

C:\c-lang แล้วโฟลเดอร์ของทกุบทกจ็ะถกูเปิดพร้อมกนัทัง้หมด หรือจะเลอืกเปิดเฉพาะโฟลเดอร์

ของบทท่ีต้องการ เช่น C:\c-lang\chapter2 ซึง่จะเข้าถงึไฟล์ได้ง่ายขึน้ หลงัจากนัน้กค็ลกิชื่อไฟล์

ของตัวอย่างที่ต้องการได้เลย 

สิ่งที่เราได้เรียนรู้ในบทนี้ เป็นการจัดเตรียมเครื่องมือก่อนจะเข้าสู่ขั้นตอนการเขียนโค้ด

ภาษา C อย่างแท้จริงในบทต่อ ๆ  ไป ซึ่งหากเรามีเครื่องมือที่ครบถ้วนและรู้จักวิธีการใช้งานที่ดี

พอในระดับหนึ่งแล้ว ก็จะมีส่วนช่วยให้เราศึกษาเรียนรู้ได้รวดเร็วยิ่งขึ้นด้วย



การเขียนโค้ดภาษา C  
ในเบื้องต้น

ภ	าษา C มีองค์ประกอบและข้อก�ำหนดที่ส�ำคัญหลายอย่างซึ่งเราควรรู้จักในเบื้องต้น โดย 

	สิ่งท่ีจะกล่าวถึงในบทนี้ เช่น ค�ำสงวน ค�ำสั่งที่จ�ำเป็นส�ำหรับการเขียนโค้ดในเบื้องต้น  

การแสดงผล การก�ำหนดบล็อกและค�ำอธิบายโค้ด เป็นต้น ซึ่งสิ่งเหล่านี้ล้วนเป็นพื้นฐานส�ำคัญ

ของภาษา C ที่เราต้องใช้งานกันไปตลอด

ประวัติโดยย่อของภาษา C
ภาษา C ถูกสร้างขึ้นเมื่อประมาณปี ค.ศ. 1972 โดย Dennis Ritchie ที่ห้องปฏิบัติการ 

ของ Bell Labs (หรือ AT & T ในปัจจุบัน) ซึ่งวัตถุประสงค์เร่ิมแรกก็เพื่อใช้ในระบบ Unix  

อย่างไรก็ตาม Dennis Ritchie ไม่ใช่ผู้บุกเบิกในการสร้างภาษา C มาตั้งแต่เริ่มต้น แต่ภาษานี้ 

ได้จากการพฒันาเพิม่เตมิต่อจากภาษาคอมพวิเตอร์อ่ืน ๆ  ทีมี่อยูก่่อนแล้วในขณะนัน้ และหลงัจาก

ยคุของ Dennis Ritchie ก็มหีลายองค์กรทีไ่ด้น�ำภาษา C มาพฒันาเพิม่เตมิเรื่อยมา ซึง่เราสามารถ

สรุปวิวัฒนาการที่เกี่ยวเนื่องกับภาษา C โดยสังเขปตั้งแต่อดีตจนถึงปัจจุบัน ได้ดังนี้

•• 1960: ภาษา ALGO

๏๏ สร้างโดยองค์กรระหว่างประเทศ (International Committee)

๏๏ ไม่มีข้อก�ำหนดการใช้งานที่ชัดเจน เนื่องจากมีลักษณะที่เป็นนามธรรม (Abstract) 

มากเกินไป

•• 1963: ภาษา CPL (Combine Programming Language)

๏๏ สร้างขึ้นที่มหาวิทยาลัยเคมบริดจ์ (Cambridge University)

๏๏ มีลักษณะที่เจาะจงมากเกินไป จึงไม่สะดวกต่อการใช้งานจริง
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•• 1967: ภาษา BCPL (Basic Combine Programming Language)

๏๏ สร้างโดย Martin Richards ที่มหาวิทยาลัยเคมบริดจ์ 

๏๏ ยังมีลักษณะที่เจาะจงเหมือนเดิม จึงเหมาะกับการใช้งานเฉพาะอย่าง เพราะขาด

ความยืดหยุ่นต่อการใช้งานทั่ว ๆ  ไป

•• 1970: ภาษา B

๏๏ สร้างโดย Ken Thompson ที่ห้องปฏิบัติการ Bell Labs (AT &T) 

๏๏ สร้างขึ้นจากพื้นฐานของภาษา BCPL (จึงเป็นที่มาของชื่อภาษา B) โดยแก้ไข 

ข้อบกพร่องหลายอย่างและท�ำให้ภาษามีขนาดเล็กลง เช่น การลดจ�ำนวนคีย์เวิร์ด 

แต่ก็ยังเหมาะกับการแก้ปัญหาที่มีลักษณะเฉพาะเจาะจงเหมือนเดิม

•• 1972: ภาษา C

๏๏ สร้างโดย Dennis Ritchie

๏๏ สร้างขึ้นจากพื้นฐานของภาษา BCPL และภาษา B ร่วมกัน จึงกลายเป็นที่มาของ

ชื่อภาษา C ว่าพัฒนาต่อจากภาษาในตระกูล B

๏๏ ภาษา C มีวิวัฒนาการต่อเนื่องมาหลายเวอร์ชัน ซึ่งสามารถสรุปได้ดังนี้

๏๏ 1972: ก�ำเนิดภาษา C (หรือเรียกว่า C72)

๏๏ 1978: K&R C (หรือเรียกว่า C78) โดย K มาจากชื่อของ Ken Thompson 

และ R มาจากชื่อของ Dennis Ritchie

๏๏ 1989: ANSI C (หรือเรียกว่า C89)

๏๏ 1990: ISO C (C90) 

๏๏ 1999: C99

๏๏ 2011: C11

๏๏ 2017: C17

๏๏ 2023: C23 (เป็นเพียงการคาดการณ์ในขณะที่เขียนหนังสือเล่มนี้ แต่ยังไม่มี

การประกาศใช้งานจริง)

ข้อดีและข้อเสียของภาษา C
ถงึแม้ภาษา C จะถูกสร้างมานานมากแล้ว รวมถึงเป็นต้นแบบให้กบักบัภาษาอื่น ๆ  อีกหลาย

ภาษา หากนบัจากอดตีถงึปัจจบุนั กถ็อืว่าเป็นภาษาทีป่ระสบความส�ำเรจ็และมอีทิธพิลต่อเทคโนโลยี

ด้านไอทมีากทีส่ดุอีกภาษาหนึง่ และมกีลุม่นกัพฒันาจ�ำนวนมากจากทัว่โลกทีย่งัคงเลอืกใช้ภาษา C 
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กนัต่อไป ถงึแม้จะมภีาษาอื่น ๆ  ท่ีถกูพฒันาขึน้มาภายหลงัและพยายามจะมาทดแทนภาษานีก้ต็าม 

แต่ภาษา C กย็งัเป็น 1 ใน 5 ของภาษาคอมพวิเตอร์ทีผู่ใ้ช้งานมากทีสุ่ดในโลกไม่เคยเปลีย่นแปลง 

ถึงอย่างไรก็ตาม ภาษา C ก็มีข้อดีและข้อเสียเช่นเดียวกับภาษาอื่น ๆ  ซึ่งเราสามารถสรุปได้ดังนี้

ข้อดีบางส่วนของภาษา C

•• มีรูปแบบไวยากรณ์การเขียนโค้ดที่ไม่ยากและเข้าใจได้ง่าย

•• สามารถเรียนรู้ได้ในระยะเวลาอันรวดเร็ว จึงเหมาะที่จะศึกษาเป็นภาษาเริ่มแรก ก่อน

ก้าวไปสู่ภาษาอื่น ๆ  ต่อไป เช่น C++, C# เป็นต้น

•• ท�ำงานได้เร็วกว่าเมื่อเทียบกับภาษาอื่น ๆ  ถือเป็นจุดเด่นที่ส�ำคัญยิ่งของภาษานี้

•• มีไลบรารีให้เลือกใช้จ�ำนวนมากและครอบคลุมการท�ำงานที่ส�ำคัญทั้งหมด

•• รองรบัการใช้งานในทกุระบบ เนื่องจากภาษา C เป็นพืน้ฐานทีถ่กูใช้ในการพฒันาระบบ 

ปฏิบัติการทั้งหมดไม่ว่าจะเป็น Unix/Linux, Windows, Mac, iOS, Android, ...  

ดังนั้น จึงสามารถน�ำโค้ดที่เขียนไปใช้กับทุกระบบ ตามค�ำกล่าวที่ว่า write once, 

compile everywhere

ข้อเสียบางส่วนของภาษา C

•• ภาษา C เปน็ภาษาแบบ Procedural (Function) ไมใ่ช่ภาษาแบบ OOP (Object Ori-

ented Programming) จงึอาจเกดิความยุง่ยากต่อการน�ำไปสร้างเป็นแอปพลเิคชนัทีซ่บั

ซ้อนมากขึน้ เมื่อเทยีบกับภาษาทีเ่ป็น OOP เช่น C++, C#, Java, Objective-C เป็นต้น

•• ไม่มีระบบจัดการปัญหา Garbage Collection หรือส่วนของหน่วยความจ�ำที่ไม่จ�ำเป็น

ต้องใช้งานต่อไปอีก อาจท�ำให้เกดิปัญหาหน่วยความจ�ำเตม็ หรือมีพืน้ทีว่่างเหลอืไม่พอ

•• ไม่มีวิธีการป้องกันและจัดการข้อผิดพลาดในแบบ Exception Handling เหมือนที่มี

ในภาษาอื่น ๆ  จึงอาจท�ำให้เกิดข้อผิดพลาดในระหว่างรันได้ง่าย 

•• ภาษา C ยังขาดเทคนิคที่จะช่วยให้การเขียนโค้ดนั้นง่ายขึ้น บางอย่างก็ใช้วิธีการที่ 

ล้าสมัย ถ้าเทียบกับภาษาใหม่ ๆ  ท่ีสร้างขึ้นในภายหลัง ซึ่งส่วนใหญ่จะมีแนวคิดและ

หลักการที่ทันสมัยมากกว่า ทั้งนี้ก็อาจเนื่องมาจากภาษา C นั้น ถูกสร้างมานานมาก

แล้ว และเป็นรากฐานของภาษาอื่น ๆ  อีกหลายภาษา รวมถึงมีหลายมาตรฐาน ดังนั้น 

การเปลี่ยนแปลงกฎเกณฑ์ต่าง ๆ  จึงท�ำได้ยาก
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ค�ำสงวนของภาษา C
ค�ำสงวน (Reserved Words) หรือคีย์เวิร์ด (Keywords) เป็นค�ำส�ำหรับใช้เป็นค�ำสั่งเพื่อ

ควบคุมหรอืก�ำหนดวธิกีารท�ำงานในภาษา C ซึง่เราจะน�ำค�ำเหล่านีไ้ปตัง้เป็นชื่อตวัแปร หรอืฟังก์ชนั

ไม่ได้ โดยค�ำที่ถูกใช้เป็นค�ำสงวนในภาษา C คือ

auto do goto signed unsigned

break double if sizeof void

case else int static volatile

char enum long struct while

const extern register switch inline (C99+)

continue float return typedef restrict (C99+)

default for short union _Bool (C99+)

นอกจากนี ้ยงัมคี�ำสงวนอกีบางส่วนทีถู่กเพิม่เตมิเข้ามาในเวอร์ชนัหลงั ๆ  แต่เรามักไม่ค่อย

ได้ใช้งานส�ำหรับการเขียนโปรแกรมทั่ว ๆ  ไป กันบ่อยนัก จึงไม่ขอน�ำมากล่าวถึง โดยวัตถุประสงค์

พอสังเขปส�ำหรับค�ำสงวนบางส่วน มีดังนี้ (รายละเอียดที่ชัดเจนของค�ำเหล่านี้ เราจะได้เรียนรู ้

ในภายหลัง)

•• int, float, char, double, long, _Bool :  ใช้ในการก�ำหนดชนิดข้อมูลของตัวแปร

•• if, else, switch, case, default :  ใช้ในการก�ำหนดเงื่อนไขเพื่อตดัสนิใจ หรอืควบคมุ

โครงสร้างการท�ำงานของโปรแกรมนั่นเอง

•• for, while, do :  รูปแบบการวนลูปเพื่อการท�ำซ�้ำ

•• break :  ใช้เพื่อหยุดการวนรอบของลูป หรือออกจากเงื่อนไขแบบ switch case

•• void :  การส่งค่าเข้าและออกจากฟังก์ชัน

•• goto :  ก�ำหนดต�ำแหน่งที่จะข้ามไปท�ำงาน

•• auto, signed, const, extern, register, unsigned, volatile :  ใช้ร่วมกบัการประกาศ 

ตัวแปรส�ำหรับกรณีเฉพาะ

•• return :  ส�ำหรับการส่งค่ากลับออกจากฟังก์ชัน หรือหยุดการท�ำงานของฟังก์ชัน

•• continue :  ให้วนลูปถัดไปทันที โดยไม่ท�ำค�ำสั่งที่เหลือภายในลูป
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•• enum :  สร้างชุดหรือกลุ่มของค่าคงที่ (Set of constants)

•• sizeof :  ส�ำหรับการตรวจสอบขนาด

•• struct, typedef :  สร้างชนิดให้กับกลุ่มข้อมูลแบบโครงสร้าง (Structures)

•• union :  ก�ำหนดกลุ่มตัวแปรที่จะใช้ต�ำแหน่งและพื้นที่จัดเก็บข้อมูลบนหน่วยความจ�ำ 

ร่วมกัน

ทบทวนการสร้างไฟล์ภาษา C
ในบททีแ่ล้ว เราได้ทราบแนวทางการสร้างและทดสอบไฟล์ภาษา C กนัไปแล้ว โดยในบทนี้  

ก็มีหลายกรณีที่เราต้องเขียนโค้ดตัวอย่าง เพื่อทดสอบการใช้งานควบคู่กันไป ทั้งนี้ เราจ�ำเป็น 

ต้องแยกแต่ละตัวอย่างไว้คนละไฟล์ จึงขอน�ำวิธีการสร้างไฟล์ภาษา C ที่เคยกล่าวไว้ในบทที่แล้ว

มากล่าวทบทวนอีกครั้งหนึ่ง ดังนี้

•• ส�ำหรบัตวัอย่างในบทที ่2 เราจะเก็บไฟล์ทัง้หมดเอาไว้ที ่C:\c-lang\chapter2 ดงันัน้ 

เราจ�ำเป็นต้องสร้างโฟลเดอร์ chapter2 ซ้อนไว้ในโฟลเดอร์ c-lang 

•• ใน VS Code ให้เปิดโฟลเดอร์ C:\c-lang\chapter2 ที่ได้สร้างเอาไว้

•• เมื่อต้องการสร้างไฟล์ตัวอย่างส�ำหรับบทนี้ ก็

คลิกที่ไอคอน New File แล้วก�ำหนดชื่อไฟล์

โดยให้มีส่วนขยายเป็น .c เท่าน้ัน ซึ่งในบทนี้

จะตั้งชื่อตัวอย่างต่าง ๆ  เป็น example2-1.c, 

example2-2.c ... เป็นเช่นนี้ไปเรื่อย ๆ

องค์ประกอบของการเขียนโค้ดภาษา C ในเบื้องต้น
ไม่ว่าจะเขียนโค้ดเพื่อวัตถุประสงค์ใดก็ตาม เราจ�ำเป็นต้องใช้ข้อก�ำหนดพื้นฐานของภาษา

เหมือน ๆ  กัน ดังนั้น ก่อนที่เราจะเข้าสู่ขั้นตอนการเขียนโค้ดที่ซับซ้อนมากขึ้นในล�ำดับต่อ ๆ  ไป  

ก็ควรรู้จักกับองค์ประกอบของการเขียนโค้ดในเบื้องต้นเอาไว้ล่วงหน้า เพราะมันคือส่ิงจ�ำเป็นที่

เราต้องน�ำไปใช้งานอยู่ตลอด โดยจะแยกแต่ละประเดน็ทีน่่าสนใจออกเป็นหวัข้อต่าง ๆ  ดังต่อไปนี้

ค�ำสั่ง #include

ค�ำสั่ง include ในภาษา C จะใช้ส�ำหรับการอ้างถึงไฟล์ภายนอกที่จัดเก็บชุดค�ำสั่งพิเศษ ที่

ต้องน�ำเข้ามาใช้งานร่วมกับโค้ดในไฟล์นั้นดังแนวทางในภาพ
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ทั้งนี้ สาเหตุที่เราต้องอ้างถึงชุดค�ำสั่งจากไฟล์ภายนอกก็เนื่องจาก ตามปกตินั้น ชุดค�ำสั่ง 

ดังกล่าว ไม่ใช่พ้ืนฐานที่จ�ำเป็นส�ำหรับการท�ำงานทั่ว ๆ  ไปของภาษา C แต่อาจใช้ในบางกรณี  

ดังนั้น เมื่อใดที่จ�ำเป็นต้องใช้ ก็จะอ้างถึงด้วยค�ำสั่ง include ในรูปแบบดังนี้

	 #include <ชื่อไฟล.์h>
หรือ	 #include "ชื่อไฟล.์h"

กลุ่มไฟล์ที่จัดเก็บชุดค�ำสั่งพิเศษดังกล่าว เราเรียกว่า เฮดเดอร์ (header) ด้วยเหตุนี้ จึง

มีส่วนขยายเป็น .h ทั้งหมด โดยไฟล์เหล่านี้ เราจะได้เรียนรู้เพิ่มเติมต่อไปเรื่อย ๆ  แต่เฮดเดอร์ที่

เราจะได้ใช้งานอยู่บ่อย ๆ  ก็คือ stdio.h ซึ่งจากที่ผ่านมาจะเห็นว่า เราเขียนโค้ดบรรทัดแรกเป็น

#include <stdio.h>

•• include เป็นค�ำสงวนของภาษา C ที่ใช้อ้างถึงไฟล์ภายนอกดังที่กล่าวมาแล้ว โดย

ในกรณีนี้ต้องเขียนเครื่องหมาย # ก�ำกับไว้ข้างหน้า เพื่อให้แตกต่างจากค�ำสั่งทั่วไป

•• stdio.h ค�ำว่า stdio ย่อมาจาก standard input/output ซึ่งเป็นมาตรฐานการรับและ

แสดงผลข้อมูลทางจอภาพ ถ้าเราไม่อ้างถึงเฮดเดอร์อันนี้ เมื่อเรียกใช้ฟังก์ชันที่เกี่ยว

กับการรับและแสดงผลข้อมูล เช่น puts, gets, printf, scanf และอีกหลายฟังก์ชัน 

ก็จะเกิดข้อผิดพลาดเมื่อรันทดสอบ ซึ่งเราจะได้เรียนรู้เพิ่มเติมในภายหลัง

ถ้าเราติดตั้งตัวแปลภาษา C ตามวิธีการของหนังสือเล่มนี้ (กล่าวไว้ในบทที่ 1) ต�ำแหน่ง

ของไฟล์เฮดเดอร์ ก็น่าจะอยู่ที่ C:\mingw64\x86_64-w64-mingw32\include ซึ่งถ้าเราลอง

เปิดเข้าไปดูก็จะพบกับไฟล์จ�ำนวนมาก ในลักษณะดังนี้
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การประกาศเฮดเดอร์ ให้เขียนไว้ส่วนหัวของไฟล์ก่อนจะเร่ิมต้นโค้ดหลัก เพื่อให้มันถูก

ประมวลผลก่อนส่วนโค้ดที่เราเขียนในล�ำดับถัดมา ซึ่งตามปกติ ในการเขียนโค้ดที่ซับซ้อนขึ้น เรา

อาจต้องอ้างถึงเฮดเดอร์มากกว่า 1 อัน โดยใช้หลักการเดิมทั้งหมด เช่น

#include <stdio.h>

#include <math.h>

#include <string.h>

ฟังก์ชัน main
ในภาษา C (รวมถึงภาษาคอมพิวเตอร์โดยส่วนใหญ่) จะใช้ฟังก์ชันที่ชื่อ main เพื่อเป็น

จุดเริ่มต้นในการท�ำงาน ซึ่งความจริงนั้น นอกจากค�ำว่า main แล้วอาจมีองค์ประกอบอื่น ๆ  ที่เรา

สามารถเขียนเพิ่มเติมร่วมกับค�ำว่า main ได้ แต่ในเบื้องต้นนี้ จะแนะน�ำเพียงแบบเดียวไปก่อน

นั่นคือ

void main() {

	

}

•• void เป็นค�ำสงวนในภาษา C ซึง่ใช้เพื่อบ่งชีว่้าฟังก์ชนันี ้จะไม่มีการส่งข้อมูลใด ๆ  กลบั

ออกไปจากฟังก์ชัน

•• main เป็นชื่อฟังก์ชันหลักของโค้ดโปรแกรมนั้น ซึ่งเป็นส่วนแรกที่จะถูกเรียกขึ้นมา

ท�ำงาน
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การก�ำหนดบล็อกค�ำสั่งด้วยวงเล็บ { }

การกระท�ำหรือด�ำเนินการบางอย่าง อาจประกอบด้วยค�ำสั่งย่อย ๆ  มากกว่า 1 ค�ำสั่ง และ

เพื่อให้เราทราบขอบเขตว่าการกระท�ำน้ัน ประกอบด้วยค�ำสัง่ย่อย ๆ  ใดบ้าง ในภาษา C จะใช้วงเลบ็ 

{ } เป็นตวัก�ำหนดขอบเขต โดยน�ำค�ำสัง่ย่อย ๆ  ที่จะด�ำเนนิการต่อเนื่องกนัไปตามล�ำดบัมาเขยีนไว้

ในวงเล็บ { } ดังรูปแบบต่อไปนี้

{

	 ค�ำสั่งที ่1
	 ค�ำสั่งที ่2
	 ค�ำสั่งที ่3
	 ...

}

แต่ละค�ำสั่งภายในบล็อก ควรเยื้องเข้าไปเป็นระยะ 1 แท็บ โดยให้จุดเริ่มต้นของแต่ละ

บรรทดัอยูใ่นแนวเดยีวกัน แม้จะไม่ใช่ข้อบังคับ แต่ก็เป็นสิง่ทีน่ยิมท�ำกนัทัว่ไป เพราะช่วยให้โค้ดนัน้

อ่านง่ายขึ้น ซึ่งจากที่ผ่านมาจะเห็นว่า เราได้ก�ำหนดวงเล็บ { } ต่อท้ายฟังก์ชัน main เพื่อก�ำหนด

ค�ำสั่งย่อย ๆ  ที่จะด�ำเนินการ เช่น

void main() {

	 ก�ำหนดค�ำสั่งย่อย ๆ  ไว้ในนี้
}

การเขียนวงเล็บเปิด { เพื่อเริ่มต้นบล็อกค�ำสั่งนั้น เราอาจวางไว้ที่บรรทัดถัดไป หรือจะ

เขียนต่อจากท้ายบล็อกในบรรทัดเดียวกันก็ได้ ดังวิธีการต่อไปนี้

•• 	 วิธีที่ 1	 New Line Block โดยเขียนวงเลบ็เปิด { เพื่อเริม่ต้นบลอ็กค�ำสัง่ ทีบ่รรทดั

ถัดไป เช่น

void main() 

{

	 ค�ำสั่งย่อย ๆ
	 ...

}
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•• 	 วธิทีี ่2	 In-Line Block โดยเขยีนวงเลบ็เปิด { ต่อท้ายบลอ็กในบรรทดัเดยีวกนั เช่น

void main() {

	 ค�ำสั่งย่อย ๆ
	 ...

}

การเขียนโค้ดภาษา C ในยุคแรก ๆ  จะนิยมใช้แบบที่ 1 เป็นส่วนใหญ่ เพราะอ่านโค้ดได้

ง่ายกว่า แต่ในยุคหลงั ๆ  ท่ีการเขยีนโค้ดจะซับซ้อนและยดืยาวมากขึน้เร่ือย ๆ  เราจงึนยิมใช้แบบที่ 

2 มากกว่า เพราะใช้พื้นที่ในการเขียนโค้ดน้อยกว่า จึงท�ำให้โค้ดดูสั้นลง แต่อย่างไรก็ตาม ไม่มีกฎ

เกณฑ์หรือข้อบงัคับว่าเราต้องใช้แบบใด ทัง้น้ีผู้อ่านสามารถใช้แบบใดกไ็ด้ทีต่นถนดั และส�ำหรบัใน

หนังสือเล่มนี้ จะเลือกใช้แบบที่ 2 เป็นหลัก ซึ่งเป็นรูปแบบที่พบเห็นในการใช้งานจริงได้มากกว่า

การก�ำหนดจุดสิ้นสุดค�ำสั่งด้วยเครื่องหมาย ;

ค�ำสั่งต่าง ๆ  ในภาษา C ที่เราเขียน มักใช้เพื่อท�ำสิ่งใดสิ่งหนึ่งโดยเฉพาะ ดังนั้น เราอาจ 

ต้องน�ำค�ำสัง่ย่อย ๆ  หลายอันมาใช้งานร่วมกนั เพื่อด�ำเนนิการอย่างใดอย่างหนึง่ ด้วยเหตนุีจ้งึต้องมี

สิง่ท่ีใช้ระบขุอบเขตหรอืจดุสิน้สดุในแต่ละค�ำสัง่ โดยในภาษา C จะใช้เคร่ืองหมาย Semicolon (;)  

เพื่อก�ำหนดจุดสิ้นสุดของแต่ละค�ำสั่ง โดยวางเครื่องหมายนี้ต่อท้ายค�ำสั่ง เช่น

void main() {

	 ค�ำสั่งที ่1;		  <= เขียนเครื่องหมาย ; ปิดท้าย เพื่อบ่งชี้ว่า สิ้นสุดค�ำสั่งที ่1
	 ค�ำสั่งที ่2;		  <= เขียนเครื่องหมาย ; ปิดท้าย เพื่อบ่งชี้ว่า สิ้นสุดค�ำสั่งที ่2
	 ค�ำสั่งที ่3;		  <= เขียนเครื่องหมาย ; ปิดท้าย เพื่อบ่งชี้ว่า สิ้นสุดค�ำสั่งที ่3
	 ...

}

และจากการที่เราระบุเครื่องหมาย ; ต่อท้าย เพื่อระบุจุดสิ้นสุดค�ำสั่ง ดังนั้น จึงสามารถ

น�ำค�ำสั่งถัดไป มาเขียนต่อเนื่องในบรรทัดเดียวกันได้ เพราะมีเครื่องหมาย ; เป็นตัวแบ่งหรือบ่งชี้ 

จุดสิ้นสุดค�ำสั่งอยู่แล้ว เช่น

void main() {

	 ค�ำสั่งที ่1;	 ค�ำสั่งที ่2;	 ค�ำสั่งที ่3;
	 ...

}
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การเขียนค�ำอธิบายโค้ด (Comment)
เราสามารถเขยีนข้อความแทรกลงในโค้ด เพื่ออธบิายเกีย่วกบัโค้ดส่วนนัน้พอสงัเขป หรอื

จะเขียนข้อความในวัตถุประสงค์อื่น ๆ  ทั้งนี้ เมื่อเราย้อนกลับมาอ่านโค้ดในภายหลัง หรือเมื่อส่ง

โค้ดให้กับคนอื่น ๆ  ต่อไป ก็จะอ่านเข้าใจโค้ดส่วนน้ันได้เร็วขึ้น ซึ่งวิธีการเขียนค�ำอธิบายโค้ดใน

ภาษา C นั้น อาจท�ำแบบใดแบบหนึ่ง ดังนี้

การเขียนค�ำอธิบายแบบบล็อก (Block Comment)
วิธีนี้ จะก�ำหนดจุดเริ่มต้นและสิ้นสุดบล็อกด้วยสัญลักษณ์ /*  */  ตามล�ำดับ โดยนับตั้งแต่

สญัลกัษณ์ /* เป็นต้นไป จะถอืเป็นค�ำอธบิายทัง้หมด จนกว่าจะเจอสัญลกัษณ์ */ จงึจะถอืว่าส้ินสุด

ค�ำอธิบาย ดังนั้น เราจึงสามารถเขียนค�ำอธิบายหลายบรรทัดไว้ในบล็อกเดียวกันได้ เช่น

/* example2-0.c */

/* C Programming Language 

   Written by Dennis Ritchie	

*/

void main() {					    /* main program */

	 puts("Hello World");		  /* display message */

	 /* puts("Goodbye"); */		 /* โค้ดบรรทัดนี้ไม่ถูกประมวลผล
							          แม้จะเป็นค�ำสั่งในภาษา C ก็ตาม
							          เพราะเขียนไว้ใน Block Comment
							       */

}

การเขียนค�ำอธิบายแบบบรรทัด (Line Comment)
ค�ำอธิบายแบบนี้ จะใช้สัญลักษณ์ // เป็นตัวก�ำหนดจุดเริ่มต้น และถือว่าจุดสิ้นสุดบรรทัด 

(ต�ำแหน่งที่เรากด <Enter> เพื่อขึ้นบรรทัดใหม่) เป็นจุดสิ้นสุดค�ำอธิบาย นั่นแสดงว่า เราจะเขียน

ค�ำอธิบายท่ียาวได้ไม่เกิน 1 บรรทดั และถ้าต้องการเขยีนค�ำอธบิายทีย่าวหลายบรรทดั ต้องก�ำหนด

ด้วยสัญลักษณ์ // ไปทุกบรรทัด เช่น

//example2-0.c

//C Programming Language 

//Written by Dennis Ritchie	
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void main() {				   //main program 

	 puts("Hello World");	 //display message

	 //puts("Goodbye");		 //โค้ดบรรทัดนี้ไม่ถูกประมวลผล
						      //แม้จะเป็นค�ำสั่งในภาษา C ก็ตาม
						      //เพราะเขียนตามหลัง Line Comment
}

การแสดงข้อความในเบื้องต้น
ในการเขียนโค้ดภาษา C นั้น ไม่ว่าจะเป็นการทดสอบหรือเพื่อใช้งานจริง ก็อาจมีกรณีที่

ต้องแสดงข้อความบางอย่างแก่ผู้ใช้ ซึ่งอาจเป็นข้อความทั่วไป การแสดงผลลัพธ์ ค�ำแจ้งเตือน 

รวมถงึการแสดงข้อผดิพลาดต่าง ๆ  โดยการแสดงข้อความตามท่ีกล่าวมา อาจเป็นเพยีงการแสดง

ข้อความแบบง่าย ๆ  หรืออาจเป็นข้อความทีม่กีารจดัรูปแบบกไ็ด้ ส�ำหรับข้อความทีมี่การจดัรูปแบบ

ที่ซับซ้อนขึ้นจะกล่าวถึงในบทที่ 4 แต่ในบทนี้ จะแนะน�ำเพียงการเขียนข้อความพื้นฐานธรรมดา

ไปก่อน ดังรายละเอียดต่อไปนี้

การแสดงข้อความด้วยฟังก์ชัน puts( )

วิธีการแสดงข้อความแบบที่ง่ายที่สุดในภาษา C น่าจะเป็นการใช้ฟังก์ชัน puts( ) ในรูป

แบบดังนี้

puts("ข้อความที่ต้องการแสดง")

•• ฟังก์ชัน puts( ) อยู่ในกลุ่มเฮดเดอร์ stdio.h ดังนั้น เราต้องอ้างอิงเฮดเดอร์นี้ด้วย  

#include <stdio.h> เอาไว้ล่วงหน้าเหมือนที่เคยท�ำมา จึงจะใช้งานฟังก์ชันนี้ได้

•• ข้อความทีจ่ะแสดงดว้ย puts( ) ต้องเขยีนไว้ในเครื่องหมายค�ำพดูแบบ " " เท่านัน้ ถึง

จะเป็นตัวเลขก็ต้องเขียนไว้ในเครื่องหมายนี้เช่นกัน เช่น "123"

•• ฟังก์ชัน puts( ) แสดงได้เพียงข้อความเดียว ถ้าเราจะแสดงหลายข้อความก็ต้อง

ก�ำหนดแต่ละข้อความด้วยฟังก์ชัน puts( ) แยกกัน หรือใช้ฟังก์ชัน puts( ) หลาย

ครั้งนั่นเอง

•• ฟังก์ชัน puts( ) เป็นการแสดงข้อความ 1 บรรทัด ดังนั้น เมื่อเราใช้ฟังก์ชัน puts( ) 

เพื่อแสดงข้อความครั้งถัดไป มันจะถูกน�ำไปแสดงหรือขึ้นบรรทัดใหม่โดยอัตโนมัติ
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•• ข้อความทีอ่ยู่ในเครื่องหมาย " " อนัเดียวกัน ต้องเขยีนให้จบในบรรทดัเดยีวกนั จะแยก 

บางส่วนไปขึน้บรรทดัใหม่ไม่ได้ (ความจรงิมวีธิทีีท่�ำได้ แต่จะมีปัญหาการเว้นระยะห่าง) 

ถ้าข้อความนัน้ยาวเกนิไป ไม่สามารถเขยีนจบในบรรทดัเดยีวกนั วธิแีก้ปัญหาในเบือ้งต้น 

คือ ให้แยกเป็นข้อความย่อย ๆ  แล้วก�ำหนดไว้ในเครื่องหมาย " " คนละอัน

ส�ำหรับแนวทางการใช้งาน ให้เราดูจากตัวอย่างต่อไปนี้ ซึ่งวิธีการสร้างไฟล์ตัวอย่าง 

ในภาษา C ได้กล่าวเอาไว้แล้ว

ตัวอย่าง 2-1 	การแสดงข้อความอย่างง่ายด้วยฟังก์ชัน puts( )

#include <stdio.h>

void main() {

	 puts("C is a real-world, widely available and ...");

	 puts("C is a small, efficient, powerful, and ...");

	 puts("C has been standardized, portable and ...");

}

การแสดงข้อความด้วยฟังก์ชัน printf( )
ตามปกตินั้น เรามักใช้ printf( ) กับข้อความที่มีการจัดรูปแบบบางอย่าง โดยตัว f ที่

เขียนต่อท้ายชื่อฟังก์ชัน มาจากค�ำว่า format ที่หมายถึงการจัดรูปแบบนั่นเอง แต่อย่างไรก็ตาม  

ในเบื้องต้นนี้ เราจะใช้ฟังก์ชัน printf( ) เพื่อแสดงข้อความธรรมดาที่ยังไม่มีการจัดรูปแบบใด ๆ  

เช่นเดียวกับ puts( ) โดยข้อแตกต่างที่ส�ำคัญในเบื้องต้นของ 2 ฟังก์ชันนี้คือ

•• ฟังก์ชัน puts( ) จะแสดงข้อความโดยขึ้นบรรทัดใหม่โดยอัตโนมัติ

•• ฟังก์ชัน printf( ) หากแสดงข้อความแบบธรรมดา จะแสดงที่บรรทัดเดิมต่อเนื่องไป

เรื่อย ๆ
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ส�ำหรับแนวทางการใช้ฟังก์ชัน printf( ) ในเบื้องต้น ให้ดูจากตัวอย่างต่อไปนี้ 

ตัวอย่าง 2-2 	การแสดงข้อความอย่างง่ายด้วยฟังก์ชัน printf( ) 

#include <stdio.h>

void main() {

   printf("C is a real-world, widely available and ...");

   printf("C is a small, efficient, powerful, and ...");

   printf("C has been standardized, portable and ...");

}

จากผลลัพธ์จะเห็นได้ว่า printf( ) จะเขียนข้อความต่อท้ายข้อความเดิมในบรรทัดเดียวกัน

ไปเร่ือย ๆ  ท้ังนี้ ส�ำหรับวิธีการแก้ไขให้ค�ำสั่ง printf( ) แสดงข้อความที่บรรทัดใหม่ จะกล่าวถึง 

ในหัวข้อถัดไป

ตัวอย่าง 2-3 	การแสดงข้อความด้วยฟังก์ชัน printf( )

#include <stdio.h>

void main() {

	 printf("123");

	 printf(" + ");

	 printf("456");

	 printf(" = ");

	 printf("579");

}
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อักขระพิเศษส�ำหรับขึ้นบรรทัดใหม่ (\n)

ถ้าเรามข้ีอความย่อย ๆ  หลายอันทีจ่ะแสดงผล กต้็องใช้ฟังก์ชนั puts( ) หรอื printf( ) ซ�ำ้    

ตามจ�ำนวนข้อความจนครบ ดงัตวัอย่างทีผ่่าน ๆ  มาน่ันเอง ซึง่การเรียกฟังก์ชนัเดมิซ�ำ้   แบบน้ีถอื

เป็นข้อบกพร่องทีเ่ราควรแก้ไข โดยวธิกีารทีจ่ะแนะน�ำในเบือ้งต้นคอื การแทรกอักขระพเิศษลงใน

ข้อความเพื่อให้เกิดการขึ้นบรรทัดใหม่ โดยไม่จ�ำเป็นต้องใช้ puts( ) หรือ printf( ) ซ�้ำหลายครั้ง  

ดังหลักการต่อไปนี้

•• ให้แทรกอักขระพิเศษคือ \n (หมายถึง New Line) ลงในข้อความ ณ ต�ำแหน่งที่

ต้องการขึ้นบรรทัดใหม่

•• ในข้อความเดียวกัน (ในเครื่องหมาย " " เดียวกัน) จะแทรก \n ลงไปกี่ครั้งก็ได้ โดย

จะเกิดการขึ้นบรรทัดใหม่ทุกครั้งในต�ำแหน่งที่เป็นอักขระ \n

•• ความจรงิแลว้ อกัขระพเิศษทีข่ึน้ต้นด้วย \ ยงัมอีกีหลายอนั โดยเราเรยีกอกัขระพเิศษ

ในกลุ่มนี้ว่า Escape Sequence ซึ่งจะกล่าวรายละเอียดเพิ่มเติมในบทที่ 3

เนื่องจากการแทรกอักขระ \n ลงในข้อความ เป็นเพียงเร่ืองง่าย ๆ  จึงขอให้ดูแนวทาง 

การใช้งานจากตัวอย่างต่อไปนี้ได้เลย

ตัวอย่าง 2-4 	การแทรกอักขระพิเศษ \n ลงในข้อความเพื่อขึ้นบรรทัดใหม่

#include <stdio.h>

void main() {    

	 printf("one\n");

	 printf("two\n");

	 printf("three\n");

	 printf("four\n");

	 printf("five\nsix\nseven\n");

	 puts("\neight");

	 puts("\nnine");

	 puts("ten\n");

}
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ตัวอย่าง 2-5 	การแทรกอักขระพิเศษ \n ลงในข้อความเดียวกัน (อยู่ในเครื่องหมาย " " คู่

เดียวกัน) เพื่อขึ้นบรรทัดใหม่

#include <stdio.h>

void main() {

    puts("\n1989: ANSI C\n1990: ISO C\n1999: C99");

    printf("\n2011: C11\n2017: C17\n2023: C23\n");

}

สิ่งที่เราได้เรียนรู้ในบทน้ี ถึงจะเป็นเพียงพื้นฐานของภาษา C ในเบื้องต้น แต่มันคือสิ่ง

ส�ำคัญที่เราต้องใช้งานกันอยู่ตลอด โดยการเขียนโค้ดในบทต่อ ๆ  ไป เราจ�ำเป็นต้องน�ำส่ิงที่ได้ 

กล่าวถึงในบทนี้ ไปใช้งานร่วมกันแทบทุกกรณี




